
 InterSnoop Help Index

Click on an object below to learn more about it...

...or select from the topics listed below.

Commands
File menu
Edit menu
Action menu
Options menu
Help menu

You can use the following server lists to help you in your InterSnooping endeavors:
•      Big List of Whois Servers 
•      Big List of Ph Servers 

Distribution and Licensing Information
Quick and Easy Ordering Information



File menu commands

The File menu offers the following commands:

Print Prints the current document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Save As Text Saves the current document as a plain text file.
Exit Exits InterSnoop.



Edit menu commands

The Edit menu offers the following commands:

Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into a Query or Server window
Delete Deletes selected data.
Select All Selects the entire document.
Find Finds the specified text in the document.
Remove Entry Removes the selected entry from the list.
Clear Window Clears the document window.



Action menu commands

The Action menu offers the following commands to help you perform your queries:

Finger Performs a Finger query.
Whois Performs a Whois query.
Ph Performs a Ph query.
DNS Lookup Performs a DNS Lookup on a machine.
Ping ICMP Pings a host.
Cancel Action Cancels any pending query.
WinSock Info Displays winsock.dll version and information.



Options menu commands

The Options menu offers the following commands:

Restore Toolbars Restores all toolbars to default locations.
Toolbar Shows or hides the toolbar.
Input Bar Shows or hides the input bar.
Cancel Button Shows or hides the cancel button.
Status Bar Shows or hides the status bar.
Restore Toolbars Restores toolbars to the top of InterSnoop’s window frame
Preferences Configure preferred settings for InterSnoop.
Font... Changes the default document font.
Save Options Saves your current settings.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



Save As Text command (File menu)

Use this command to save and name the active document.    InterSnoop displays the Save As Text    
dialog box so you can name your document. 



File Save As Text dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    InterSnoop adds the extension you specify in 
the Save File As Type box.

NOTE: InterSnoop for Windows 95 and Windows NT supports long filenames, in which you can use 
most characters, including spaces, periods, and semicolons. If you use spaces or semicolons in a 
filename, you must enclose the filename in double quotation marks (" ").

Save as type
InterSnoop saves all documents as text files and automatically appends the .TXT extension to the file 
name (if you haven’t already provided an extension).

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Exit command (File menu)

Use this command to end your InterSnoop session.    You can also use the Close command on the 
application Control menu.    InterSnoop prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Copy command (Edit menu)

Use this command to copy selected document data onto the clipboard.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C



Paste command (Edit menu)

Use this command to paste data from the clipboard into one of the Query or Server combo boxes.

Shortcuts
Keys: CTRL+C



Delete command (Edit menu)

Use this command to delete the currently selected text.    NOTE: the main document text is read-only, so 
the delete command does not apply here.

Shortcuts
Keys: DEL



Select All command (Edit menu)

Use this command to select the entire document into the clipboard.



Remove Entry command (Edit menu)

Use this command to remove the selected query or server from its list.



Clear Window command (Edit menu)

Use this command to completely clear the document window.



Finger command (Action menu)

Use this command to perform a finger query.    If no query is specified, InterSnoop will attempt to finger 
the given machine. 



Whois command (Action menu)

Use this command to perform a Whois query.



Ph command (Action menu)

Use this command to perform a CCSO Ph query.    The query will be interpreted as specified in the “Ph 
Query Type” box.



DNS Lookup command (Action menu)

Use this command to perform a Domain Name Server Lookup on a machine. You must first select (or 
“highlight”) the name or IP address of the machine you wish to look up.



Ping command (Action menu)

Use this command to ICMP Ping a machine to see if it is alive or not.    You must first select (or “highlight”) 
the name or IP address of the machine you wish to ping.



Cancel Action command (Action menu)

Use this command to cancel a query that is still pending.



WinSock Info command (Action menu)

Use this command to display information about your machine’s implementation of WinSock.



Toolbar command (Options menu)

Use this command to display and hide the Main Toolbar, which includes buttons for some of the most 
common commands in InterSnoop (such as Finger).    A check mark appears next to the menu item when 
the Toolbar is displayed.

InterSnoop’s toolbars are “dockable” - this means you can “tear them off” and “dock” them in various 
configurations around the application’s frame.    You can also “float” them by pulling them away from 
InterSnoop’s window frame. 

See Toolbar for help on using the InterSnoop’s toolbars.



Input Bar command (Options menu)

Use this command to display and hide the Input Bar, which is the part of InterSnoop’s interface that allows 
you to formulate queries.    A check mark appears next to the menu item when the Input Bar is displayed.

InterSnoop’s toolbars are “dockable” - this means you can “tear them off” and “dock” them in various 
configurations around the application’s frame.    You can also “float” them by pulling them away from 
InterSnoop’s window frame. 

See Toolbar for help on using the InterSnoop’s toolbars.



Query (Input Bar)

This is where you enter your query.    For instance, if you wanted to finger the user “goober,” you would 
type “goober” in this box.    If, however, you wish to finger a particular machine, delete all text from the 
query box.    The “Finger Server” machine will be used as the target of the finger.

The Query Input area is implemented as a “Drop-Down Combo Box” which remembers the last twenty 
elements that have been in it.    Click on the down arrow to the right of the input area to select from this 
list.



Finger Server (Input Bar)

This is where you specify the machine from which you would like to retrieve information for your finger 
queries.

The Finger Server area is implemented as a “Drop-Down Combo Box” which remembers the last twenty 
elements that have been in it.    Click on the down arrow to the right of the input area to select from this 
list.



Whois Server (Input Bar)

This is where you specify the machine from which you would like to retrieve information for your finger 
queries.

The Whois Server area is implemented as a “Drop-Down Combo Box” which remembers the last twenty 
elements that have been in it.    Click on the down arrow to the right of the input area to select from this 
list.



Ph Server (Input Bar)

This is where you specify the machine from which you would like to retrieve information for your finger 
queries.

The Ph Server area is implemented as a “Drop-Down Combo Box” which remembers the last twenty 
elements that have been in it.    Click on the down arrow to the right of the input area to select from this 
list.

Additionally, you will find (to the right of the Ph Server Combo Box) a section that allows you to specify 
what type of Ph Query you would like to perform.    For instance, if you had a telephone number (say 555-
8088) and wanted to know whose it was, you would click the Phone radio button and then enter 5558088 
in the Query area.    Name and Email work similarly.

The Custom selection is for advanced users who wish to perform specialized searches.    When this 
button is selected, the Query text is interpreted as a complete Ph query (in Ph query syntax of course).



Cancel Button command (Options menu)

Use this command to display and hide the animated Cancel Button.    A check mark appears next to the 
menu item when the Cancel Button is displayed.

InterSnoop’s toolbars are “dockable” - this means you can “tear them off” and “dock” them in various 
configurations around the application’s frame.    You can also “float” them by pulling them away from 
InterSnoop’s window frame. 

See Toolbar for help on using the InterSnoop’s toolbars.



Restore Toolbars command (Options menu)

Use this command to display all toolbars in a default configuration.

InterSnoop’s toolbars are “dockable” - this means you can “tear them off” and “dock” them in various 
configurations around the application’s frame.    You can also “float” them by pulling them away from 
InterSnoop’s window frame. 

See Toolbar for help on using the InterSnoop’s toolbars.



Preferences command (Options menu)

Use this command to display a dialog box that will let you configure some aspects of InterSnoop’s 
behavior.



Save Options command (Options menu)

Use this command to save your current application options and preferences.



Font command (Options menu)

Use this command to display a dialog box that will let you choose the font that InterSnoop uses.



Toolbar

Click on an object below to learn more about it...



Status Bar command (Options menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the InterSnoop window.    To display or hide the status bar, 
use the Status Bar command in the Options menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using InterSnoop and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of InterSnoop.



Context Help command 

Use the Context Help command to obtain help on some portion of InterSnoop.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the InterSnoop window, such as another Toolbar button.    The Help topic will be shown for 
the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the InterSnoop window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the a window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

Allows you to choose the default font for InterSnoop.



Find command (Edit menu)

Use this command to bring up a window that will allow you to perform text searches on the document.



Find dialog box

Allows you to perform text searches on the document.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



InterSnoop Preferences Dialog Box

This is where you specify the default behavior of InterSnoop.

Clear screen contents before each query
Check this box to have InterSnoop erase the contents of the main window 
before every new query.

Use word wrap mode for main window
Check this box to have InterSnoop wrap lines that extend beyond the width of 
the window.

Remember toolbar locataions
Check this box to have InterSnoop remember the locations of its toolbars.    
This is useful if you have found a configuration you like and would like to 
make it the default.

Remember main window placement
Check this box to have InterSnoop “remember” both the size and placement 
on your desktop.    The next time you launch InterSnoop, it will come up in the 
same place and have the same size as when you last quit InterSnoop.



Quick and Easy Ordering Information

InterSnoop is NOT freeware - it is commercial software.    You may use your unlicensed copy for a maximum of 10 
days for evaluation purposes only.    If you decide to continue using InterSnoop beyond this 10 day evaluation period, 
you must purchase a license.

SPECIAL OFFER FOR INTRODUCTORY RELEASE USERS !
Since this is the first release of InterSnoop, you may currently order introductory-release discounted licenses for 
InterSnoop from AKI Software Solutions by payment with check or money order.    This introductory offer entitles you 
to free upgrades of InterSnoop for 1 full year from the date of purchase. 

To order introductory discounted licenses for InterSnoop, simply print out this form and fill out the information below.

You will be sent a licensed name and key combination that will “unlock” your copy of InterSnoop software, 
transforming it into an officially licensed copy.    Officially licensed copies of InterSnoop of course do not display 
registration reminders of any kind.

The current price of one introductory discounted license is currently ONLY $US 15
(Very significant site licensing discounts are available starting at 50-user licenses.    Please email 
sales@akiss.lm.com for site licensing information.)

NOTE: AKI Software Solutions reserves the right to end this introductory offer with the next release.

NAME ___________________________________________

COMPANY ___________________________________________

STREET 1 ___________________________________________

STREET 2 ___________________________________________

CITY ___________________________________________

STATE / PROVINCE ___________________________________________

COUNTRY ___________________________________________

ZIP / POSTAL CODE ___________________________________________

E-MAIL ___________________________________________

Product: Cost: # of Copies: Product Total:
InterSnoop $15.00 US    

x
__________ $ __________

PA residents add 7% sales tax __________ + $ __________
TOTAL $ __________

Make checks payable to:  AKI Software Solutions

Mail To:  AKI Software Solutions
 5901 Nicholson Street, Suite 100
 Pittsburgh, PA 15217 USA

Money orders will be processed immediately: licensing information will be emailed to you immediately if you include 
an email address.    Orders via personal check will be processed as soon as checks clear.    International orders are 



welcome- please send checks drawn on a US Bank.



AKI Software Solutions Software Distribution and Licensing
 Information

Distribution

This shareware software may be freely distributed, provided that:

(1) Such distribution includes only the original archive supplied by AKI Software Solutions.    You may 
not alter, delete or add any files in the distribution archive.
(2) The distribution does not include a registration number.    In particular, you may not distribute a 
registered version of InterSnoop.
(3)  No money is charged to the person receiving the software, beyond reasonable cost of packaging 
and other overhead.

Licensing

By receiving and/or using AKI Software Solutions software, you accept the following Evaluation and 
Registered User Agreement.    This agreement is a binding legal agreement between AKI Software 
Solutions and the purchasers, users or evaluators of AKI Software Solutions’ software and products.    If 
you do not intend to honor this agreement, remove all installed AKI Software Solutions software from your 
computer now.

(1) Evaluation (Unregistered) and Registered User Agreement

You may evaluate the Shareware program for maximum of ten calendar days, after which you must 
register the program with AKI Software Solutions or remove the software from your computer. 

You may allow other users to evaluate copies of the unregistered Shareware. All evaluation users are 
subject to the terms of this agreement.

The evaluator/user/buyer/owner is not allowed to attempt to reverse engineer, disassemble or decompile 
AKI Software Solutions software and products. 

AKI Software Solutions name and any logo or graphics file that represents our software may not be used 
in any way to promote products developed with our software.    All parts of AKI Software Solutions 
software and products are copyright protected.    No program, code, part, image, video clip, audio sample, 
text or computer generated sequence of images may be copied or used in any way by the user except as 
intended within the bounds of the single user program.

The evaluator/user/buyer/owner of AKI Software Solutions software will indemnify, hold harmless, and 
defend AKI Software Solutions against lawsuits, claims, costs associated with defense or accusations that 
result from the use of AKI Software Solutions software. 
 
AKI Software Solutions is not responsible for any damages whatsoever, including loss of information, 
interruption of business, personal injury and/or any damage or consequential damage without limitation, 
incurred before, during or after the use of our products.    Our entire liability, without exception, is limited to 
the customers' reimbursement of the purchase price of the software (maximum being the suggested retail 
price as listed by AKI Software Solutions) in exchange for the return of the product, all copies, registration 
papers and manuals, and all materials that constitute a transfer of ownership from the customer back to 
AKI Software Solutions.

Each registered copy of the AKI Software Solutions software may be used in only one single location by 



one user.    Use of the software means that you have loaded the program and run it or have installed the 
program onto a computer.    If you install the software onto a multi-user platform or network, each and 
every individual user of the software must be registered separately.

You may make one copy of the registered software for backup purposes, providing you only have one 
copy installed on one computer being used by one person. If any person other than yourself uses AKI 
Software Solutions’ software registered in your name, regardless of whether it is at the same time or 
different times, then this agreement is being violated! 

The sale of and or distribution of registered copies of this software is strictly forbidden.    It is a violation of 
this agreement to loan, rent, lease, borrow, or transfer the use of registered copies of AKI Software 
Solutions software products.



 InterSnoop’s Whois Servers List!

Note: This list is being provided here in it’s entirety for the benefit of InterSnoop users.    AKI 
Software Solutions cannot in any way guarantee the validity of the information provided herein.    
Up to date copies of the following list are obtainable via anonymous FTP as described below.

sipb.mit.edu:/pub/whois/whois-servers.list

List of Internet whois servers, 9 May 1995 (Version 3.88)

This list was collected and compiled by Matt Power of M.I.T.

Questions or comments about this list should be sent to the address:

    mhpower@mit.edu

Preferred server name              Associated institution
---------------------------------------------------------------------
camb.com                           Cambridge Computer Associates C=US
gte.com                            GTE Laboratories C=US
whois.pacbell.com                  Pacific Bell C=US
wp.psi.com                         Performance Systems International C=US
whois.sunquest.com                 Sunquest Information Systems C=US

teetot.acusd.edu                   University of San Diego C=US
zippy.telcom.arizona.edu           University of Arizona C=US
ducserv.duc.auburn.edu             Auburn University C=US
whois.bates.edu                    Bates College C=US
whois.berkeley.edu                 University of California at Berkeley C=US
bingsuns.cc.binghamton.edu         State University of New York at Binghamton C=US
bsu.edu                            Ball State University C=US
caltech.edu                        California Institute of Technology C=US
horton.caltech.edu                 California Institute of Technology C=US
csufres.csufresno.edu              California State University - Fresno C=US
csuhayward.edu                     California State University - Hayward C=US
csus.edu                           California State University - Sacramento C=US
whois.cwru.edu                     Case Western Reserve University C=US
cc.fsu.edu                         Florida State University C=US
gettysburg.edu                     Gettysburg College C=US
gmu.edu                            George Mason University C=US
whois.dfci.harvard.edu             Dana-Farber Cancer Institute C=US
hmc.edu                            Harvey Mudd College C=US
humboldt.edu                       Humboldt State University C=US
indiana.edu                        Indiana University C=US
kean.edu                           Kean College C=US
prdb.merit.edu                     Merit Network C=US
whois.messiah.edu                  Messiah College C=US
whois.rsmas.miami.edu              University of Miami, Rosentiel School of Marine and 
Atmospheric Sciences C=US
mit.edu                            Massachusetts Institute of Technology C=US
whois.msstate.edu                  Mississippi State University C=US
vax2.winona.msus.edu               Minnesota State University - Winona C=US
info.nau.edu                       Northern Arizona University C=US
whois.ncsu.edu                     North Carolina State University C=US
nd.edu                             University of Notre Dame C=US
earth.njit.edu                     New Jersey Institute of Technology C=US
vm1.nodak.edu                      North Dakota State University C=US
acfcluster.nyu.edu                 New York University, Courant Institute C=US
sun1.mcsr.olemiss.edu              University of Mississippi C=US
austin.onu.edu                     Ohio Northern University C=US
ph.orst.edu                        Oregon State University C=US
osu.edu                            Ohio State University C=US
oswego.edu                         SUNY College at Oswego C=US
whois.oxy.edu                      Occidental College C=US



ems.psu.edu                        Pennsylvania State University, College of Earth and Mineral 
Sciences C=US
info.psu.edu                       Pennsylvania State University C=US
cs.rit.edu                         Rochester Institute of Technology C=US
whois.cc.rochester.edu             University of Rochester C=US
whitepages.rutgers.edu             Rutgers University C=US
whois.sdsu.edu                     San Diego State University C=US
sonoma.edu                         Sonoma State University C=US
stanford.edu                       Stanford University C=US
camis.stanford.edu                 Stanford University C=US
hpp.stanford.edu                   Stanford University C=US
whois.slac.stanford.edu            Stanford Linear Accelerator Center C=US
stjohns.edu                        St. John's University C=US
sunysb.edu                         State University of New York, Stony Brook C=US
syr.edu                            Syracuse University C=US
whois.bcm.tmc.edu                  Baylor College of Medicine C=US
tstc.edu                           Texas State Technical College C=US
directory.uakron.edu               University of Akron C=US
whois.ubalt.edu                    University of Baltimore C=US
uc.edu                             University of Cincinnati C=US
thor.ece.uc.edu                    University of Cincinnati C=US
directory.ucdavis.edu              University of California at Davis C=US
uchicago.edu                       University of Chicago C=US
whois.ucsb.edu                     University of California at Santa Barbara C=US
ucsd.edu                           University of California at San Diego C=US
weber.ucsd.edu                     University of California at San Diego, Division of Social 
Sciences C=US
cgl.ucsf.edu                       University of California at San Francisco, School of Pharmacy 
C=US
whois.uh.edu                       University of Houston C=US
whois.umass.edu                    University of Massachusetts at Amherst C=US
umbc.edu                           University of Maryland, Baltimore County C=US
lookup.umd.edu                     University of Maryland C=US
umn.edu                            University of Minnesota C=US
ns.unl.edu                         University of Nebraska at Lincoln C=US
whois.uoregon.edu                  University of Oregon C=US
whois.upenn.edu                    University of Pennsylvania C=US
x500.utexas.edu                    University of Texas at Austin C=US
netlib2.cs.utk.edu                 na-net (linear algebra on computers) C=US
whois.vims.edu                     Virginia Institute of Marine Science C=US
whois.virginia.edu                 University of Virginia C=US
whois.wfu.edu                      Wake Forest University C=US
wisc.edu                           University of Wisconsin C=US
wpi.wpi.edu                        Worcester Polytechnic Institute C=US
ibc.wustl.edu                      Washington University C=US

vm1.hqadmin.doe.gov                U.S. Department of Energy Headquarters C=US
wp.doe.gov                         U.S. Department of Energy C=US
llnl.gov                           Lawrence Livermore National Laboratory C=US
x500.arc.nasa.gov                  NASA Ames Research Center C=US
x500.gsfc.nasa.gov                 NASA Goddard Space Flight Center C=US
larc.nasa.gov                      NASA Langley Research Center C=US
wp.nersc.gov                       National Energy Research Supercomputer Center C=US
seda.sandia.gov                    Sandia National Laboratories C=US

whois.nic.ddn.mil                  DDN Network Information Center C=US
whois.nrl.navy.mil                 Naval Research Laboratory C=US

wp.es.net                          Energy Sciences Network C=US
ds.internic.net                    Network Solutions, Inc. (non-MILNET/non-POC) C=US
whois.internic.net                 Network Solutions, Inc. C=US
whois.lac.net                      Latin America & Caribbean Whois Server C=EC
pilot.njin.net                     New Jersey Intercampus Network C=US
whois.ripe.net                     Reseaux IP Europeens C=NL

whois.morris.org                   Morris Automated Information Network C=US

whois.risc.uni-linz.ac.at          Research Institute for Symbolic Computation, University of 
Linz C=AT
whois.wu-wien.ac.at                Wirtschaftsuniversitaet Wien C=AT
archie.au                          Australian Academic and Research Network C=AU



whois.adelaide.edu.au              University of Adelaide C=AU
wp.adelaide.edu.au                 University of Adelaide C=AU
deakin.edu.au                      Deakin University C=AU
whois.monash.edu.au                Monash University C=AU
uwa.edu.au                         University of Western Australia C=AU
whois.gu.uwa.edu.au                University of Western Australia, University Computer Club C=AU
sserve.cc.adfa.oz.au               University College, Australian Defense Force Academy C=AU
jethro.ucc.su.oz.au                University of Sydney C=AU
whois.kuleuven.ac.be               Katholieke Universiteit Leuven C=BE
elem4.vub.ac.be                    Inter-university Institute for High Energies C=BE
whois.belnet.be                    Belgian National Research Network C=BE
whois.camosun.bc.ca                Camosun College, Victoria, B.C. C=CA
whois.doc.ca                       Communications Canada (The Federal Department of 
Communications) C=CA
ac.nsac.ns.ca                      Nova Scotia Agricultural College C=CA
whois.queensu.ca                   Queen's University, Kingston, Canada C=CA
whois.unb.ca                       University of New Brunswick C=CA
panda1.uottawa.ca                  University of Ottawa C=CA
dvinci.usask.ca                    University of Saskatchewan, Engineering C=CA
whois.usask.ca                     University of Saskatchewan C=CA
phys.uvic.ca                       University of Victoria, Physics & Astronomy C=CA
whois.uwo.ca                       University of Western Ontario C=CA
horton.yorku.ca                    York University C=CA
nic.switch.ch                      SWITCH Teleinformatics Services C=CH
whois.ci.ucr.ac.cr                 University of Costa Rica Computer Center C=CR
whois.cr                           CRNet NOC C=CR
whois.mff.cuni.cz                  Charles University, Faculty of Mathematics and Physics C=CZ
whois.vutbr.cz                     Technical University of Brno C=CZ
whois.fh-koeln.de                  Fachhochschule Koeln C=DE
whois.fzi.de                       Forschungszentrum Informatik C=DE
hermes.informatik.htw-zittau.de    HTW Zittau/Goerlitz Elektrotechnik/Informatik C=DE
whois.th-darmstadt.de              Darmstadt University of Technology C=DE
whois.tu-chemnitz.de               Technische Universitaet Chemnitz C=DE
deins.informatik.uni-dortmund.de   University of Dortmund C=DE
whois.uni-regensburg.de            Universitaet Regensburg C=DE
whois.uni-c.dk                     Danish Computing Centre for Research and Education C=DK
whois.eunet.es                     EUnet, Goya, Spain C=ES
whois.dit.upm.es                   Tech. Univ. Madrid, Telecommunications Highschool C=ES
cs.hut.fi                          Helsinki University of Technology C=FI
cc.jyu.fi                          Jyvaskyla University C=FI
oulu.fi                            Oulu University C=FI
vtt.fi                             Technical Research Centre of Finland C=FI
whois.citilille.fr                 CITI Lille - France C=FR
whois.univ-lyon1.fr                Universite Claude Bernard Lyon I C=FR
whois.forthnet.gr                  FORTHnet (Foundation of Research and Technology Hellas) C=GR
wp.forthnet.gr                     FORTHnet (Foundation of Research and Technology Hellas) C=GR
sangam.ncst.ernet.in               National Centre for Software Technology C=IN
isgate.is                          Association of Research Networks in Iceland C=IS
dsa.nis.garr.it                    GARR-NIS c/o CNR-CNUCE C=IT
whois.nis.garr.it                  GARR-NIS c/o CNR-CNUCE C=IT
whois-server.l.chiba-u.ac.jp       Chiba University C=JP
whois.cc.keio.ac.jp                Keio University C=JP
whois.cc.uec.ac.jp                 University of Electro-Communications C=JP
whois.nic.ad.jp                    Japan Network Information Center C=JP
whois.nic.nm.kr                    Korea Network Information Center C=KR
whois.tue.nl                       Eindhoven University of Technology C=NL
cantsc.canterbury.ac.nz            University of Canterbury C=NZ
directory.vuw.ac.nz                Victoria University, Wellington C=NZ
waikato.ac.nz                      Waikato University C=NZ
whois.elka.pw.edu.pl               Faculty of Electronic Engineering, Warsaw University of 
Technology C=PL
whois.ia.pw.edu.pl                 Institute of Automatic Control, Warsaw University of 
Technology C=PL
archie.inesc.pt                    Instituto de Engenharia de Sistemas e Computadores C=PT
chalmers.se                        Chalmers University of Technology C=SE
whois.gd.chalmers.se               Gothenburg Universities' Computing Centre C=SE
kth.se                             Royal Institute of Technology C=SE
sics.se                            Swedish Institute of Computer Science C=SE
whois.sunet.se                     SUNET (Swedish University Network) C=SE
whois.uakom.sk                     SANET (WAN of Slovak academic institutions) C=SK
src.doc.ic.ac.uk                   Imperial College C=GB



whois.lut.ac.uk                    Loughborough University C=GB
info.cnri.reston.va.us             Corporation for National Research Initiatives, Knowbot 
interface C=US
hippo.ru.ac.za                     Rhodes University, Grahamstown C=ZA
whois.und.ac.za                    University of Natal (Durban) C=ZA

--------------------------------------------------------------------------------



 InterSnoop’s CCSO Ph Servers List!

Note: This list is being provided here in it’s entirety for the benefit of InterSnoop users.    AKI 
Software Solutions cannot in any way guarantee the validity of the information provided herein.

· Albert Einstein College of Medicine ns.aecom.yu.edu
· Algonquin C. of App. Arts and Tech., Ontario, Canada algnet.algonquinc.on.ca
· American University, Washington DC ph.american.edu
· Aston University, United Kingdom gopher.aston.ac.uk
· Australian Defence Force Academy ns.adfa.oz.au
· Australian National University cis.anu.edu.au
· Bar Ilan University, Israel (Experimental, Hebrew) vm.biu.ac.il
· Bates College mother.bates.edu
· Baylor College of Medicine ns.bcm.tmc.edu
· Beth Israel Hospital (Harvard Univ.) ns.bih.harvard.edu
· Bilkent University ns.bilkent.edu.tr
· Board of Governors Universities, IL USA ns.bgu.edu
· Boston University ns.bu.edu
· Bowling Green State University ph.bgsu.edu
· Bradley University ns.bradley.edu
· Brigham Young University kolob.byu.edu
· Brown University ns.brown.edu
· Bucknell University ns.bucknell.edu
· CHUUG/EUnet, Switzerland chsun.eunet.ch
· CRS4 Ctr for Adv Studies, Rsrch, and Dev, Italy ns.crs4.it
· Calvin College calvin.edu
· Camosun College, Victoria, B.C. Canada cso.camosun.bc.ca
· Canisius College Faculty/Staff gort.canisius.edu
· Carnegie Inst. of Washington Geophysical Lab granite.ciw.edu
· Carnegie Inst. of Washington, Dept. of Ter. Mag. dtm.ciw.edu
· Centre de Ressources Informatiques de Haute-Normandie ns.crihan.fr
· Cerritos College ns.cerritos.edu
· Chicago State University, IL USA ns.csu.bgu.edu
· Chinese University of Hong Kong ns.cuhk.hk
· Clemson University gopher.clemson.edu
· Cleveland State University ns.csuohio.edu
· Cliometric Society clionet.cas.muohio.edu
· Colby College gopher.colby.edu
· Columbia University gutentag.cc.columbia.edu
· Concordia University, Montreal, Quebec, Canada phone.concordia.ca
· Cornell College, Iowa ns.cornell.iowa.edu
· Cornell Directory of Legal Academia ns.law.cornell.edu
· Cornell University qi.cornell.edu
· Curtin Univ. of Technology, Perth, Australia info.curtin.edu.au
· Dana Farber Cancer Institute ns.dfci.harvard.edu
· Danville Area Community College, Danville, Illinois ns.dacc.cc.il.us
· Dartmouth College dnd.dartmouth.edu
· Deakin University deakin.edu.au
· Delft University of Technology, Netherlands gopher.tudelft.nl
· Drake University ns.drake.edu
· Duke University phonebk.duke.edu
· Eastern Illinois University, IL USA ns.eiu.bgu.edu
· Eastern Kentucky University acs.eku.edu
· Ecole Centrale Paris, France ph.ecp.fr
· Ecole Polytechnique Federale de Lausanne, Switzerland gopher.epfl.ch
· Ecole des Hautes Etudes Commerciales, Montreal, Canada ph.hec.ca
· Educational Computing Network, IL USA ns.ecn.bgu.edu
· Eidg. Technische Hochschule, Zurich ural.ethz.ch
· Embry Riddle Aeronautical University, WEST cso.pr.erau.edu
· Emory University dooley.cc.emory.edu
· Energy Sciences Network ph.es.net
· Environmental Protection Agency (EPA) earth1.epa.gov
· Eurecom Institute, Sophia -  Antipolis, France eurecom.cica.fr
· Fairfield University funrsc.fairfield.edu
· Fanshawe College, London, Ontario, Canada admin.fanshawec.on.ca
· Florida Institute of Technology Faculty/Staff sci-ed.fit.edu



· Florida State University mailer.fsu.edu
· Geodetic Survey of Canada ns.geod.emr.ca
· Georgia Institute of Technology lu-serve.gatech.edu
· Georgia Southern University ns.gasou.edu
· Georgia State University ph.gsu.edu
· Glassboro State University gboro.glassboro.edu
· Global Cycling Network cycling.org
· Government of New Brunswick, Canada picture.gov.nb.ca
· Governors State University, IL USA ns.gsu.bgu.edu
· Groningen University, Arts/Theol/Phil, Netherlands ns.let.rug.nl
· Gustavus Adolphus College ns.gac.edu
· Hamline University piper.hamline.edu
· Harvard University fas-ph.harvard.edu
· Helsinki University of Technology ns.cs.hut.fi
· Humber College of Applied Arts and Technology, Canada admin.humberc.on.ca
· INSA - Lyon, France ns.univ-lyon1.fr
· Illinois Math and Science Academy ns.imsa.edu
· Illinois State University, Normal, IL USA ns.ilstu.edu
· Indiana State University ph.indstate.edu
· Indiana University of Pennsylvania ns.iup.edu
· Indiana University - Purdue Univ. at Indianapolis hyrax.iupui.edu
· Intl. Ctr. for Genetic Eng. & Biotech., Italy genes.icgeb.trieste.it
· Iowa State University of Science and Technology isuad1.iastate.edu
· Israel - wide Univ/Corp Email Searches (Experimental) vm.tau.ac.il
· Johns Hopkins University rad.hcf.jhu.edu
· Katholieke Universiteit Leuven, Belgium ns.kuleuven.ac.be
· Keio University, Sci. & Tech. Campus, Japan bash.cc.keio.ac.jp
· Kennesaw State College gopher.kennesaw.edu
· Kent State University phoenix.kent.edu
· Kutztown University kutztown.edu
· Lakehead University flash.lakeheadu.ca
· Lambton College, Canada ns.lambton.on.ca
· Lawrence Livermore National Laboratory ns.llnl.gov
· Lehigh University ns.lehigh.edu
· Lewis University cs.lewisu.edu
· Library of Congress marvel.loc.gov
· Linkoping University, Sweden ns.liu.se
· Los Alamos National Laboratory lanl.gov
· Loughborough University of Technology, United Kingdom dir.lut.ac.uk
· Loyola University, Chicago ns.luc.edu
· Magnavox Electronic Systems Company gw1.magec.com
· Mahidol University, Thailand, Staff ns.mahidol.ac.th
· Massachusetts Institute of Technology mitdir.mit.edu
· Massey University, New Zealand ns.massey.ac.nz
· McGill Univ. Research Centre for Intelligent Machines lightning.mcrcim.mcgill.edu
· McMaster University, Canada, Faculty/Staff mcmail.cis.mcmaster.ca
· Medical University of South Carolina, Faculty/Staff qi.musc.edu
· Memorial Sloan - Kettering Cancer Center bigmac.mskcc.org
· Miami University (Ohio, USA) ph.muohio.edu
· Michigan State University Faculty/Staff cso.msu.edu
· Michigan State University Students pilot0.cl.msu.edu
· Michigan Technological University mtu-ns.mtu.edu
· Middle East Technical University (METU), Turkey mogan.cc.metu.edu.tr
· Middlebury College ns.middlebury.edu
· Mount Saint Mary's College msmary.edu
· Muhlenberg College rocky.muhlberg.edu
· NASA Lewis Research Center aruba.lerc.nasa.gov
· National Autonomous University of Mexico (UNAM) condor.dgsca.unam.mx
· National Institute of Standards and Technology cso.nist.gov
· National Institutes of Health ph.nih.gov
· National Oceanic and Atmospheric Admin., Boulder cso.erl.noaa.gov
· National Renewable Energy Laboratory ns.nrel.gov
· National Science Foundation phsrvr.nsf.gov
· National University of Singapore nuscc.nus.sg
· New York University ph.nyu.edu
· New York University Medical Center popmail.med.nyu.edu
· Nijenrode University, Netherlands gopher.nijenrode.nl
· North Carolina Cooperative Extension Service, NCSU twosocks.ces.ncsu.edu
· North Dakota State University plains.nodak.edu
· Northeast Missouri State University noc.nemostate.edu
· Northeastern Illinois University, IL USA ns.neiu.bgu.edu



· Northwest Regional Educational Laboratory ns.nwrel.org
· Northwestern University ns.nwu.edu
· ODTU Cevrimici Telefon Rehberi, Turkey knidos.cc.metu.edu.tr
· Oak Ridge National Laboratory wp.ornl.gov
· Occidental College chesire.oxy.edu
· Ohio Northern University ns.onu.edu
· Oklahoma State University bubba.ucc.okstate.edu
· Old Dominion University Faculty/Staff gopher.odu.edu
· OpenConnect Systems ph.oc.com
· Oregon Research Institute aragorn.ori.org
· Oregon State University ph.orst.edu
· Penn State University ph.psu.edu
· Plymouth State College, New Hampshire eeyore.plymouth.edu
· Portland State Univ., Schl of Eng and Applied Sciences ph.ee.pdx.edu
· Portland State University skade.cc.pdx.edu
· Princeton University princeton.edu
· Public Health Research Institute ph.phri.nyu.edu
· Purdue University directory.purdue.edu
· Quebec.Net (public phonebook for Quebec) ph.quebec.net
· Quebecor Inc. ph.quebecor.com
· Queen Mary and Westfield College, London, UK beta.qmw.ac.uk
· Queen's University, Kingston, Canada info.queensu.ca
· Queensland Institute of Medical Research, Australia panther.qimr.edu.au
· Rice University cwis.rice.edu
· Rider University genius.rider.edu
· Rijksuniversiteit Gent, Belgium infoserv.rug.ac.be
· Rose-Hulman Institute of Technology ns.rose-hulman.edu
· Roskilde Universitetscenter, Denmark ns.ruc.dk
· Rsch. Inst. for Sym. Comp. (RISC -Linz), Austria info.risc.uni-linz.ac.at
· Ryerson Polytechnic University ph.acs.ryerson.ca
· SUNY Computer Officers Association gram.cc.geneseo.edu
· SUNY System (Central) Administration cso.sunycentral.edu
· Saint Michael's College, Colchester VT smcvax.smcvt.edu
· Saint Norbert College ph.snc.edu
· Sam Houston State University niord.shsu.edu
· Sir Sandford Fleming College, Canada gopher.flemingc.on.ca
· St. John's College, Annapolis MD USA ns.sjca.edu
· St. Olaf College cso.stolaf.edu
· State University of New York at Buffalo cso.acsu.buffalo.edu
· State University of New York at Geneseo newt.cc.geneseo.edu
· State University of New York at Oswego cso.oswego.edu
· State University of New York, Potsdam College gopher.dc.potsdam.edu
· Swarthmore College ph.cc.swarthmore.edu
· Syracuse University dataserver.syr.edu
· Technical Research Centre, Finland ns.vtt.fi
· Technical University of Eindhoven, Netherlands mailhost.tue.nl
· Technical University of Nova Scotia, Canada newton.ccs.tuns.ca
· Texas A&M University ns.tamu.edu
· Texas Tech University unicorn.acs.ttu.edu
· Trent University, Peterborough, Ont., Canada blaze.trentu.ca
· Trinity College, Hartford, CT ns.trincoll.edu
· Department of Education gopher.ed.gov
· UFSIA, University of Antwerp, Belgium ns.ufsia.ac.be
· US Army Corps of Engineers, C.E.R. Lab ns.cecer.army.mil
· US Geological Survey ridgisd.er.usgs.gov
· United Medical & Dental Schools, London, UK ph.umds.ac.uk
· Universidad de Los Andes, Bogota, Colombia ph.uniandes.edu.co
· Universidad del Valle, Cali, Colombia mafalda.univalle.edu.co
· Universitaire Instelling Antwerpen, Belgium cso.uia.ua.ac.be
· Universite Catholique de Louvain annuaire.sia.ucl.ac.be
· Universite Laval, Genie Electrique cso.gel.ulaval.ca
· Universite Laval, Quebec, Canada ns.ulaval.ca
· Universite de Valenciennes, France ns.univ-valenciennes.fr
· Universite du Quebec a Montreal, Quebec, Canada cso.uqam.ca
· University College London, UK ph-server.ucl.ac.uk
· University of Alberta, Canada chinchaga.ucs.ualberta.ca
· University of Arizona ns.arizona.edu
· University of Brescia, Italy master.cci.unibs.it
· University of British Columbia, Canada phserver.ubc.ca
· University of California Systemwide Administration directory.ucop.edu
· University of California at Berkeley infocal.berkeley.edu



· University of California at Davis geology.ucdavis.edu
· University of California at Irvine qi.service.uci.edu
· University of California at Los Angeles directory.ucla.edu
· University of California at San Diego ucsd.edu
· University of California at San Francisco itsa.ucsf.edu
· University of California at Santa Barbara ucsbuxa.ucsb.edu
· University of Cape Town, South Africa gopher.cs.uct.ac.za
· University of Central Florida pegasus.cc.ucf.edu
· University of Chicago prism.uchicago.edu
· University of Cincinnati ucunix.san.uc.edu
· University of Colorado, Boulder directory.colorado.edu
· University of Colorado, Colorado Springs, Faculty/Staff ns.uccs.edu
· University of Connecticut phonebk.uconn.edu
· University of Connecticut Health Center ph.uchc.edu
· University of Durham ph0.dur.ac.uk
· University of Florida ns.ufl.edu
· University of Georgia phonebook.uga.edu
· University of Guelph, Canada info.uoguelph.ca
· University of Hamburg, Dept. Econ & Bus. Admin. ns.econ.uni-hamburg.de
· University of Hamburg, Germany playmate.uni-hamburg.de
· University of Hawaii ns.hawaii.edu
· University of Idaho Faculty/Staff owl.csrv.uidaho.edu
· University of Illinois at Chicago ns.uic.edu
· University of Illinois at Urbana-Champaign s.uiuc.edu
· University of Iowa ns.uiowa.edu
· University of Kansas School of Engineering ns.tisl.ukans.edu
· University of Kentucky ukcc.uky.edu
· University of Liege, Belgium ph.ulg.ac.be
· University of Maine Faculty/Staff goofy.umecit.maine.edu
· University of Manchester and UMIST, UK info.mcc.ac.uk
· University of Mannheim, Germany ns.uni-mannheim.de
· University of Maryland at Baltimore umabnet.ab.umd.edu
· University of Maryland, Baltimore County cso.umbc.edu
· University of Massachusetts at Amherst ns.umass.edu
· University of Memphis ns.memst.edu
· University of Minnesota ns.umn.edu
· University of Missouri Rolla -Faculty/Staff - cso phonebook.cc.umr.edu
· University of Montana selway.umt.edu
· University of Munich, Germany ns.informatik.uni-muenchen.de
· University of Nebraska at Lincoln unlmail.unl.edu
· University of Nebraska at Omaha ns.unomaha.edu
· University of New Brunswick, Canada ns.unb.ca
· University of New England, Northern Rivers, Australia elli.une.edu.au
· University of North Texas gopher.unt.edu
· University of Notre Dame ns.nd.edu
· University of Oklahoma ns.uoknor.edu
· University of Oregon whois.uoregon.edu
· University of Oslo, Norway ph.uio.no
· University of Otago, Dunedin, New Zealand ns.otago.ac.nz
· University of Pennsylvania ph.server.upenn.edu
· University of Pittsburgh direct.srv.cis.pitt.edu
· University of Pretoria, South Africa qi.up.ac.za
· University of Rhode Island phonebk.uri.edu
· University of Salzburg, Austria dsb835.edvz.sbg.ac.at
· University of South Africa (Unisa) gopher.unisa.ac.za
· University of South Carolina bigbird.csd.scarolina.edu
· University of South Florida dotrisc.cfr.usf.edu
· University of Southern California cwis.usc.edu
· University of Southern Maine Faculty/Staff csir1.usmacs.maine.edu
· University of Southhampton, UK, Dept of Mathematics mir.maths.soton.ac.uk
· University of Sydney, Australia phone.su.edu.au
· University of Sydney, Faculty of Law, Australia sulaw.law.su.oz.au
· University of Tasmania, Australia info.utas.edu.au
· University of Tennessee at Chattanooga cecasun.utc.edu
· University of Tennessee at Knoxville ns.utcc.utk.edu
· University of Texas CHPC hermes.chpc.utexas.edu
· University of Texas Medical Branch bluefin.utmb.edu
· University of Texas at Austin mojo.ots.utexas.edu
· University of Trento, Italy mambo.cs.unitn.it
· University of Tulsa ns.utulsa.edu
· University of Utah ph.cc.utah.edu



· University of Utrecht, Netherlands nic.cc.ruu.nl
· University of Vermont ns.uvm.edu
· University of Victoria, Canada gopher.uvic.ca
· University of Waterloo, Ontario, Canada uwdir.uwaterloo.ca
· University of West Bohemia, Czech Republic ph.zcu.cz
· University of Winnepeg, Canada uwpg02.uwinnipeg.ca
· University of Wisconsin - Eau Claire gopher.uwec.edu
· University of Wisconsin - La Crosse ns.uwlax.edu
· University of Wisconsin - Platteville shamu.oit.uwplatt.edu
· University of Wisconsin at Madison wisc.edu
· University of Wisconsin at Milwaukee risc1.os.uwm.edu
· Uppsala University, Sweden ns.uu.se
· Utah State University Extension Service extsparc.agsci.usu.edu
· Vanderbilt University ph.vanderbilt.edu
· Virginia Polytechnic Institute and State Univ. ns.vt.edu
· Vrije Universiteit Amsterdam csohost.cca.vu.nl
· Wake Forest University cso.wfu.edu
· Washington State Univ., Pullman serval.net.wsu.edu
· Washington University, St. Louis ns.wustl.edu
· Weizmann Institute of Science, Israel wisslc1.weizmann.ac.il
· Western Illinois University, IL USA ns.wiu.bgu.edu
· Wheaton College david.wheaton.edu
· Williams College ns.williams.edu
· Wilmington College ns.wilmington.edu
· Yale University directory.yale.edu
· York University, Canada ph.yorku.ca





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other printer 
setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that The Fingerer/32 is sending output to the printer.    
The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages 
will be displayed in their printed format.    The print preview toolbar offers you options to view either one or 
two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a 
print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of the current installed printers shown in the box.    You install printers and configure 
ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.






